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New Features & Improvements | Mobile
Security Questions
Security questions can now be viewed and edited in the Android and iOS apps. While in the app, users can tap
Login Details from the Settings menu item.

To see the previously-answered questions, users can tap Edit.
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By tapping the right-facing arrow, users are able to select new security questions.

Questions can only be used once
Users can also edit their Security Question answers by tapping the current answer to reveal the keyboard before
tapping Done. Users will then be be prompted to re-enter their password before they can save the new answer.
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Posted Schedule Push Noti cations
The following improvements have been made to push noti cations regarding posted schedules:

⚬
⚬
⚬

Store and Schedule names are now included
Date and time of shifts are included
○ The out time of a shift will only display if the Show Out Times permission is enabled.
Noti cations that are opened will take users directly to the appropriate week of the My Schedule
screen

Time O Updates Push Noti cation
A new “Time O Updates” push noti cation preference is now available for Android and iOS users with the
Request Time O permission.

The preference is OFF by default
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The noti cation will include the type of request being made, the manager’s name who has made the decision to
approve or deny the request, the amount of paid hours (when available), the start date of the request, and what
the request decision was.

New Features & Improvements | Web
ASC - Preloads
Previously, there were two sub-tabs of Preloads within the Communication tab in the Above Store Console; one
was intended to upload and edit, while the other was to provide the number of views a Preload received at each
store it was assigned to.
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Now that Preloads have been migrated to HTML, all actions can be done from one, much more intuitive area.
The main screen will display:

⚬
⚬
⚬
⚬
⚬

(1) - The name of the Preload
(2) - The active date range of the Preload
(3) - How many times the Preload displays for users
○ A Preload with a Display Count of 0 will display for users until the expiration date, or until it is
manually deleted by an ASC user
(4) - Whether or not the Preload is currently active
(5) - More actions for the Preload including:
○ The ability to copy an expired Preload to reuse
○ The option to view how many times the Preload was viewed at each store it was assigned
○ The ability to delete the Preload
○ The option to manually end a currently-active Preload

By clicking Add Preload, users are presented with three tabs. The Setup tab is where users are required to name
the Preload, set the start and end dates for its run, and list the number of times they wish the Preload to display
for each user. As mentioned above, when the Display Count is set to 0, the Preload will display until its expiration
date, or until it is manually deleted by an ASC user.
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The Design tab allows users to upload an image, type a message, and to use a variety of formatting options to
make their Preload look great.

Selecting the “Recipients by” dropdown in the Recipients tab allows users to assign Preloads to:

⚬
⚬
⚬
⚬

Everyone at a particular store
Users of a particular store and job
Users of a particular store and permission
○ Please note that a maximum of 5 permissions can be selected
Users of a particular store and schedule
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ASC - Updated Schedule Status Report PDF
The PDF export of the Schedule Status report in the ASC has been updated to match the HTML and Excel
formats.

ASC - Actual vs. Scheduled Report Dates
Improvements have been made to the Actual vs. Scheduled Labor report so that the days displayed
more-accurately represent the work week of the store(s). For example, selecting to view a store whose week
starts on a Monday will display Monday as the rst date in the report. When viewing two stores with two di erent
starting days to the week, the store’s week with the closer day to Sunday will display. For example, if one store
has a Wednesday - Tuesday week, and another store has a Thursday - Wednesday week, the date range in the
report would display Wednesday - Tuesday.

Time Range for Time O
Sites using the New Scheduler can now be con gured so they are no longer restricted by their Day Parts when
submitting Time O . This is helpful if an employee is able to work part of a morning shift, but not all of it. Now a
request is for the calendar day and not the business day. The feature works similarly to the current functionality
used in the Time O & Requests sub-tab of the Home tab, however instead of selecting which Day Part an entry
will apply to, users can uncheck an All Day box.
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Unchecking the box allows users to click on the window to the right of each date to submit a start time to request
as well as an end time.

The "From" and "To" dates/times are required before being able to save. The Comments are only required when
a site requires a reason. (Please see the next feature write-up.)
Mobile users are able to submit an entry by time range as well. From the Time O /Requests screen, users will
rst need to select the type of request they want to submit. The All Day toggle will be set to ON by default, but
turning it OFF will allow users to select their start and end times to the request.
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When reviewing the request in the Manage Time O sub-tab of the Home tab, managers can tell whether a
request was submitted as a time range (1) or for an entire day (2).

Requiring a Comment for Time O Requests
Sites can now be con gured to require employees to submit a comment when submitting their Time O and
Requests. From the employees’ perspective, they will not be able to save an entry without rst entering a
comment.

HotSchedules 4.0.56.1 Release Notes

Page | 10

Managers can then view the comments when approving/denying an entry.

Time O on Behalf of Employees
With the necessary permissions, managers will have a Create Time O button within the Manage Time O
sub-tab of the Home tab where they can submit Time O on behalf of their employees.
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The Create Time O or Request modal is where managers can make entries for their employees. When
submitting on behalf of their sta , managers can override cut o limits and blocked days. Furthermore, if the site
is con gured for Paid Time O , but an employee’s permission doesn’t allow him/her to submit the time,
managers can do it on their behalf.

⚬
⚬
⚬
⚬

(1) The Type dropdown allows managers to select what type of entry to enter (Unpaid Time O , Paid
Time O , Request O , Request to Work)
○ These options are directly related to the con guration of the site
(2) Managers can use the Employee dropdown to select for whom the entry is intended
(3) When Paid Time O is being entered, the Comments dropdown allows managers to choose a
reason for the entry
○ The reasons are created in the Time O sub-tab of the Con guration tab at the ASC level
(4) When Paid Time O is being entered, a Job must be selected from which those paid hours are
calculated from
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Upon saving a Paid Time O entry, the modal for approving and denying entries will be displayed to allow
managers to select how many hours will be “paid hours” before approving the entry.

New Personal Settings
The Personal Settings page has been updated with a new look, and depending on permissions, will allow users
to upload a pro le picture (1), edit their Preferred Name, Birthday, and Locale (2), submit Availability (3), edit their
Contact information and view Schedule and Job assignments (4).
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Time Range for Availability
One of the features of the new Personal page is the ability to submit an Availability by a range of time instead of
being restricted to Day Parts. This feature is only available to sites using the New Scheduler, and is dependent on
the calendar day and not the business day. The Personal sub-tab landing page will display the current
Availability.

When enabled, the Employee Availability sub-tab of the Sta tab will be removed.
The current Availability will always be locked so users can't edit it, however they can submit a new Availability by
clicking the Add icon.

The dates indicate when the availability became e ective.
Users are required to enter an “E ective” date for the new Availability. By leaving the Approving Manager
drop-down set to "Any," any manager with the Sta - Edit Employee permission will be able to approve the
submission. If users want to select a speci c manager to approve, they will need to select the manager from the
drop-down.
It should be noted, however, that if they’re going from any sort of limited availability to fully available, no manager
approval is needed. In these instances, managers with permissions to approve will receive a HotSchedules
Message indicating the employee is fully available now and that no other action is required.
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Additionally, users will have the option to provide a reason why the availability will be changing.

Any white on the Availability grid will display when users are available, so when they are not available to work,
the slot will be in gray. To enter a time of unavailability, they can simply click and drag anywhere in the grid to
create the entry.

The time will move in increments of 15 minutes. If users make a mistake, they can hover the mouse on either side
of the entry until an arrow displays, and then click and drag to make their adjustment. Users might also nd
situations where they attempt to drag an entire entry, but will end up creating 15-minute available slots within
their unavailable entry.
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To mark an entire day Unavailable, users can click on the day once, or twice to clear all entries for the day. To
wipe the grid clean and start from scratch, they can click the Clear Availability button at the bottom. When the
Availability is ready to submit, users can simply click Submit Availability at the bottom of the page.

One of the bene ts of this new interface is the ability to have up to 4 availabilities submitted at any given time.
This allows employees to submit temporary Availabilities for things like Spring Break and school schedules.

Once 4 submissions have been made, the Add option will no longer display.
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When Availabilities have been approved, clicking any of the Availabilities will allow users to view what the
submitted Availability was for that e ective date, and also allow them to delete it if necessary by clicking the X or
Delete Availability button.

Once an Availability is submitted and approved, it cannot be edited. Users will need to delete it, and create a
new one.
Managers who have the Sta - Edit Employee Availability permission will have the new Availability Approval
interface along with an updated sub-tab in their Home tab which will display badge noti cations. When there are
Availabilities to approve, there will be a numbered badge icon on the sub-tab for every employee with a pending
Availability change.

Upon clicking the sub-tab, managers will see the employees on the left who have Availabilities that need to be
approved. Employees are ordered by those with older requests at the top of the list, followed by employees with
the most recent requests at the bottom. In other words, those who have been waiting the longest for an approval
will be at the top of the list.
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When selected, each of the employee’s Availabilities will be displayed on the right. The current Availability, and
who it was approved by will be listed rst, followed by the Availability that needs approval, and then each
Availability in order of their e ective date. The gray bars in each grid is the employee's current Availability, and the
blue bars is the newly-submitted Availability. To view just the current availability, managers can select the expand
icon.

When denying an Availability, managers can provide a reason why. The system does not require them to provide
a reason when they deny, but they still have to click Send to complete the denial. Each approval and denial will
be sent to the employee in the form of a HotSchedules Message. Additionally, when the employee logs into the
web, and navigates to his/her Personal settings, a similar message will display indicating the status of their
Availability request.

Please note there is no UNDO option when approving or denying.
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New Sta Pro le Interface
Sites using the new Personal interface will also be con gured to use a redesigned Sta Pro le page for managers
who click on an employee's name in the Sta List. On the left, managers are able to edit personal information
such as phone number and email address. On the right, the Details tab (1) displays by default, followed by the
Jobs/Schedules tab (2), and then the Availability tab (3).

The Details tab of an employee's pro le is where managers can go for important information about the employee
such as when their next shift is and what certi cations they have.
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The top section of this tab will display the employee's next shift and what his/her username is to access the
account.

For employees who have a con rmed email address, or have their text messaging con gured, managers can
click the Send Schedule button to send a copy of any posted schedule. If an employee doesn't have his/her
email con rmed, the manager will be noti ed.

Managers can also send login details to users with a con rmed email or con gured text messaging. By clicking
Send Login, they will have the option of sending just the username, or they can check the Include Password box
to send the employee a link so they can securely change their password.

While on the Details tab of the Sta Pro le, managers can send a quick HotSchedules Message with the Message
tool.
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Managers can select from the certi cations con gured for their site to assign to employees. Enabling a new
certi cation will automatically display a date picker to con gure the expiration date, but users can also click the
dates of previously-assigned certi cations to enter a new expiration date.

The Settings panel is where various employee con gurations can be made such as account status, permission
set, and hired date.

Marked elds are editable by clicking the eld and selecting an option.
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The Jobs/Schedules tab is where managers can assign jobs and schedules to their employees.

The Schedules pane will display the schedules that are assigned below a drop-down menu of all the schedules
available to assign. When collapsed, the menu will display the number of assigned schedules out of the total
number available.
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The Jobs pane will display the jobs that are assigned below a drop-down menu of all the jobs available to assign.
When collapsed, the menu will display the number assigned jobs out of the total number available.

⚬
⚬
⚬

Imported and new-employee accounts will not have a default Primary job, however selecting one
makes it easier and quicker to schedule newly created shifts in the Scheduler.
The Skill Level for each job is an indication of the employee's ability for the speci c job, and provides
more options when using the AutoScheduler tool.
Most sites integrate their jobs with a Point of Sale system, so the Hourly Rate for each job tends to
come from there.

With the Availability tab, managers can view the employee's Availability as well as submit a new Availability on
behalf of the employee. Submitting an Availability on behalf of an employee works the same as outlined in the
Time Range for Availability section above.
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Each time an employee's Availability is saved, the employee will receive a noti cation when they navigate to their
Personal settings that a new availability was approved.

Employees will NOT receive an HS Message when a manager submits availability on their behalf.

Reports A ected by Time Range for Availability and Time O
The following scenarios will occur when a customer uses Time Range for Availability:

⚬
⚬
⚬

The Availability Report will be removed
The Availabilities option will be removed when con guring the Extended Schedule Report
The Availabilities option will be removed when con guring the Weekly Roster Report

The following scenarios will occur when a customer uses Time Range for Time O :

⚬
⚬
⚬

The Approved Time O and Employee Request Reports will be removed
The Approved Time O and Requests options will be removed when con guring the Extended
Schedule Report
The Requests option will be removed when con guring the Weekly Roster Report

Please note that the reports listed above are under construction, so they will be back soon. In the meantime, the
information they contain can be found in the Employee Information Center in the Scheduler, or from the Time O
Calendar tab within the Manage Time O sub-tab.

New Scheduler - Update to the Create House Shift Modal
The 4.0.55.1 Release (12.22.2017) introduced the ability to easily create house shifts by clicking ALT+CTRL+H if on a
PC, or ALT+COMMAND+H if on a Mac. Updates have been made to the Create House Shift modal so that only
assigned jobs and schedules will display to alleviate the risk of posting a house shift no one can pick up.

New Scheduler - Continued Removal of Locations
The 4.0.53.0 Release (09.15.2016) removed the Locations options from several areas of the Scheduler if a site did
not have any Locations con gured. The option has now been removed from the AutoScheduler, the Roster
Report, and the SmartSelect tool.

HotSchedules 4.0.56.1 Release Notes

Page | 24

New Scheduler - Display Cost Setting
Managers now have the option to hide the cost in the Scheduler. The option is enabled by default, but to remove
it from displaying, they can navigate to the Scheduler Settings and uncheck the box.

New Scheduler - Forecasting Data
Improvements have been made to the forecasting data in the Scheduler to match the forecasting data on the
Forecast Projections page.

New Scheduler - Editing Day Notes
Day Notes in the Scheduler can now be edited by their creator, or deleted by any user with the permission to
create them. While viewing a Day Note, the creator of that note can hover the mouse over it to show the edit
pencil or delete icons in the upper, right-hand corner.
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Clicking the pencil icon will allow the creator of the note to make in-line changes that will save in real time, and
upon clicking outside of the text box, the timestamp label for the note will change from “Created” to “Edited” with
the updated date and time.

Matching Forecasting and Proforma Reports
Improvements have been made to back-end calculations so that gures within the Forecasting tab will now
match the projections in the Labor Proforma II reports.
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